Appendix 12
MCU COMPUTER AND DIGITAL OPERATIONS MANUAL

General Information

The MCU is equipped with two computers to allow it to be used for several tasks:
control of the ACU-1000, map support, logging, or for digital operations (APRS,
PACTOR, and Packet). They are both loaded with common software such as MS-
Word, MS-Excel, MS-Access, and Notepad for ASCII text. The laptop is used primarily
for ACU support and maintaining the 1CS-309 (Communications Log). The Digital
operations computer also has Topo USA 5 & Street Atlas USA and Precision Mapping
map software. There is also a Wi-Fi router on the local area network to support a local
WiFi network when deployed with the SAR team command van, etc. Each computer
will be discussed separately and in more detail below.

ACU Support Computer

The ACU support computer is a laptop that is normally stored in its case and in one of
the overhead compartments for security and basic physical protection during travel. It
needs to be plugged into one of the network connections with a Cat 5 Network cable
and to AC power before operation. It should be powered up and operating before
starting the second computer. There is an unexplained anomaly relating to mast
camera operations if this power-up sequence is not followed. Also plug in the large
screen monitor located on the front wall. This can be used as a computer screen for the
laptop as well as a display for the mast camera.

ACU 1000 Operations

As might be imagined from its title, the primary function for this computer is providing
computer control of the ACU-1000 Audio Control Unit (ACU). The ACU is a
communications linking device used to allow communication between remote users who
are using different types of communication devices, such as radios with different
frequencies and/or modes. For example, the ACU can be used to enable
communication between VHF radios in FM mode and HF radios in SSB mode or
between radios and telephones, either in the public telephone system or local phones.
Transmitting and receiving by the ACU are performed by physically attached
communication devices (radios, phones, etc.). The ACU’s function is simply to pass
audio signals from the receiving device to the other linked devices which then retransmit
the signals. For example, one attached radio might be set to a police frequency while
another might be set to a fire department frequency. This would allow personnel on the
two disparate frequencies to communicate with each other. Another example would be
the linking of Forest Service, Department of Public Safety, National Guard and State
Emergency Services communications. The ACU may also be attached to the public
telephone network and to local phones to allow phone users to call or be called by radio
users. Link (net) control is performed primarily by the ACU control operator. However,
links and phone patching may be carried out by remote users without the involvement of

As of: 2/4/2007 12 -1



the control operator. Whereas the control operator may use either a computer (i.e.
laptop) or the ACU’s keypad, remote users are restricted to DTMF (keypad) use only.

Operations carried out by the control operator fall into two general categories: those
carried out prior to use of the ACU in normal operations (e.g. setup) and those carried
out during normal linking operations. Both types of operations are usually performed
through the use of a laptop computer attached to the ACU. Before describing these
operations, this guide will first discuss the screen display which the operator will be
working with as the functions are performed.

Once you turn on the computer and it is booted up, Log On as Mobile 1. There is no
password.

The Windows screen contains a menu (or task) bar at the top with the names of the
various dropdown menus (i.e. File, Options, etc.). The body of the screen is black and
has seven horizontal light green lines, spaced so that the bottom line is near the bottom
of the screen. These are Net Lines. The left margin of the screen shows the Net
Number to the left of each Net Line. Above the top net line is another such line called
the Idle Line. Along the idle line are arranged icons representing the LP-1 module and
the other interface modules present in the module cage.

Above each icon is the module’s slot number (00-12), referred to as the Module
Number. An empty slot is represented by a blank space where the module’s icon would
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appear. Each icon bears the module type name at the top (e.g. DSP-1). When modules
are connected (linked), their icons drop to a net line. All icons placed on a given net line
represent a net. Those on a different net line represent a separate net and may not
communicate with those not on their net line (unless via a Priority Net).

Module Settings

Prior to linking operations, the control operator enters settings information as necessary
for each DSP-1 and PSTN-1 interface module. To enter a module’s settings, the
operator double (left) clicks on the module’s icon. This causes the module’s settings
entry screen is to be displayed. The screen format (what is shown or asked for)
depends on whether the module is a DSP-1 or PSTN-1. As a rule, factory settings
should be used except when necessary to improve performance. For the purposes of
this guide it is assumed that most setup steps have already been completed.

Operations carried out by the control operator include the following:

- Device Connections: The linking together of two or more attached communications
devices. Individual groups of links (nets) may be established. For example, Police might
be linked to Fire.

- Net Connections: The linking together of two or more nets (groups of links).

- Priority Nets: The linking together of external devices which have been assigned to
different nets. These devices are then isolated from all devices not in the priority net.

- Monitoring: Enabling one external device to receive signals from other specified
external devices, regardless of whether they are in the same or different nets.

Control Operator Operations

Linking Two Modules (Establishing a Net)
1. Left click on first module (icon), on the idle line, to be linked.
2. Left click on second module icon to be linked.

Both modules will fall to the next free net line and will be linked for communication. The
first module will not drop to the net line until the second module has been clicked.

Adding another Module to a Net

1. Left click on the icon of the module to be added to the net.

2. Left click on the net line’s Net Number or on one of the icon’s on the line.
The new icon will fall to that line and join the other modules in the net.

Deleting a Module from the Net

1. Right click on the module to be deleted from the net.

The module to move back to the idle line and will no longer be linked.

Deleting a Net

1. Right click on the net line’s Net Number. Or right click on all icons in the net line.
All'icons in that net line will be unlinked and will move back to the idle line.

Moving a Module to a Different Net
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1. Left click on the icon of the module to be moved.

2. Left click on the target net line’s Net Number.

The icon will move to the new net line. It will no longer be linked to the modules in the
former line.

Linking Nets

1. Left click on the first net line’s Net Number.

2. Left click on the second net line’s Net Number.

The color of the two net lines will change to show that both nets are linked. Any module
in the first net may

communicate with any module in the second net. Up to three such nets can be
established.

Adding Another Net to Linked Nets

1. Left click on the Net Number of the net to be added to the link.

2. Left click on the Net Number of one of the nets already in the link.

The color of the net line added to the link will change to the same color as that of the
lines already in the

link.

Deleting a Net from Linked Nets

1. Right click on the Net Number of the first net to be deleted.

If only two nets were in the link. They will be unlinked and the color of their net lines will
return to green.

Establishing a Priority Net

Modules in a priority net need not be on the same net line. That is, they may be in
different nets. Members of a priority net are isolated from all other modules. They may
communicate with each other but cannot communicate outside that net. Likewise, other
modules cannot communicate with those in the priority net. Priority nets are used only
when the modules are already in established nets.

1. Left click on a module icon that is already in a net line.

2. Left click on the second module icon. It may be in the same or in a different net line.
A small red box containing a white Priority Net Number will appear in both icons
indicating that they are now in a priority net.

Adding Modules to a Priority Net

1. Left click on the module (icon) to be added to the priority net.

2. Left click on a module that is already in the net.

A small red box containing that Priority Net Number will appear in the icon of the module
that was added.

Deleting Modules from a Priority Net

1. Right click on the icon of the module that is to be deleted from the priority net.

The small red box within the icon will disappear showing that the module is no longer a
part of the net. To delete the entire priority net, right click on all but the last icon.
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Enabling Monitoring

This function allows the user(s) of a module to monitor communication by one or more
other modules. The monitoring module “hears” what the monitored modules hear. The
monitored modules may be in different nets (net lines) and/or in the idle line. The
monitoring module is unable to transmit to monitored modules unless they are in the
same net (as the monitoring module) or share a priority net.

1. For the module that will monitor, left click on the module (slot) number above the
icon. The module numbers are above the icons on the idle line at the top of the screen.
A green box containing an “M” will appear in the icon and the word MONITOR will
appear vertically in the left margin of the screen. All other icons in net lines will contain
a black disk.

2. For each module to be monitored, left click on the module’s icon and then left click on
MONITOR. That module’s number will appear in a white box along the bottom of the
monitoring module’s icon.

3. Continue step 2 until the module numbers of all modules to be monitored appear
beneath the icon of The monitoring module. Monitoring links remain in force even if a
monitored module is moved to another net or back to the idle line where it is no longer
linked to any other module. To enable monitoring for another module, repeat steps 1-3
for the new module.

Ending Monitoring
1. Repeat the same steps that were performed to enable monitoring but right click on
MONITOR (see step 2).

Establishing a Phone Patch

This function involves the control operator establishing communication with another
person via the public telephone network. The MCU needs to be connected via cable to
the PSTN or by satellite using the TracStar Voice Over Internet Protocol (VOIP) system.
The operator connects (links) his HSP-2 module to the PSTN-1 phone system module,
dials the remote user’'s phone number and establishes communication with the remote
user. At this time, the operator may also add other modules (radio and/or local phone)
to the link. When communication is ended, the operator ensures that the PTSN-1 link is
terminated and that all other modules are unlinked.

1. Left click on module 00 (HSP-2) icon.

2. Left click on the PSTN-1 module’s icon. The phone number entry screen is displayed.
3. Enter the telephone number.

4. Left click on DIAL.

The ACU 1000 dials the phone number.

5. Communicate with the remote user. Advise him/her that each “transmission” should
be ended with OVER to avoid confusion and that he/she should press *# before hanging
up (this will disconnect the PSTN-1).

6. If the called person neglects to transmit *# before hanging up, the PSTN-1 module
will remain linked. If this occurs, right click on the PSTN-1 module’s icon to disconnect
it. If other modules are added to the link, the control operator may enable monitoring by
the HSP-2 module.
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Other ACU Operator Control Options

There may be instances where power to the ACU 1000 is interrupted or where the
laptop computer is inadvertently disconnected from the ACU. When this happens, the
configuration / links may be lost. This section describes how the ACU configuration may
be restored and how a given configuration may be saved and reloaded at a future time if
desired.

Power Lost or ACU Temporarily Powered Down

When power is restored to the ACU 1000, the modules present in the module cage are
recognized, but they will all appear on the idle line above the net lines.

1. Click on the File dropdown menu at the top of the screen.

2. Select and click on “Restore Last Config.”.

Laptop Disconnected

1. Click on the File dropdown menu at the top of the screen.

2. Select and click on “Retrieve Current Config.”.

Saving and Recalling Configurations

A given configuration may be saved and recalled at a later time. However, when it is
recalled, the module arrangement in the ACU must be the same as when the
configuration was saved.

Saving the Configuration

1. Click on the File dropdown menu at the top of the screen.

2. Select and click on “Save Configuration”.

3. When prompted, enter the save name and complete the save.

Loading the Configuration

1. Click on the File dropdown menu at the top of the screen.

2. Select and click on “Load Configuration”.

3. When prompted, enter the save name and complete the load.

Linking all Modules

The operator may link all modules for the purpose of making a general announcement
(QST) or some other reason. Afterward, this link can be terminated and the original
configuration re-established.

1. Click on the Options dropdown menu at the top of the screen.

2. Select and click on “Connect All”".

3. Carry out announcement and any necessary communication.

4. In the Options menu, click on “Revert” (immediately below “Connect All").

Unlinking all Modules.

The operator may terminate temporary links to carry out a control function and then
revert to the pre-existing configuration.

1. Click on the Options dropdown menu at the top of the screen.
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2. Select and click on “Disconnect All”.
3. Carry out the control function(s).
4. In the Options menu, click on “Revert” (immediately below “Disconnect All”).

Mast Camera Operations

There is a Sony video camera installed on the pneumatic mast. The mast does not
need to be deployed to use the camera. It is basically live on the network whenever the
AC power is active. It is network accessible (IP address) from either computer by
clicking on the INTERNET icon, then go to FAVORITES and select the Sony Camera.
There is also a shortcut on the “desktop” that allows direct access. If you have difficulty
accessing the camera, you may have to shut both computers down and reboot them,
laptop first and then the desktop. There may a few-second delay as the camera is
accessed over the network and another popup menu with several options comes up.
Select "ActiveX Viewer". The camera view will now appear on the screen. To control
the camera view and manipulate it, select the "Control" icon. You will now be able to
move the camera up/down, right/left, and zoom in/out using the various controls.
Although you have the ability to rotate 360 degrees, there is a "Stop" which prohibits
continuous left to right or right to left in the direction of the mast. Once you reach that
point, you will have to move the camera in the opposite direction. And since the camera
is below the top of the mast, there is also a blind spot trying to look through the mast
itself. You will need to consider that when parking the MCU and the direction of the
primary incident from the vehicle. In other words, don't point the front of the truck
directly at the incident.

Video Capture

To capture video as a still for transmission (email), select the "Capture" icon. A
thumbnail of the shot will appear on the screen. If that is what you want, right click the
mouse to save the photo as a JPG file. You will now be able to attach that JPG and
send it as an email attachment using the MSN Hotmail account.

Other Support Operations

The ACU Support computer also may be used for Internet connectivity, Email, Instant
Messaging, Mast Camera Control or maintaining a communications/activity log for the
incident. Discussion of the Email web account and Instant Messaging is discussed in
Appendix 11.

Digital and Mapping Operations Computer

This computer is located on the curb side operating bench near the rear of the MCU. It
has tie-down straps attached to keep it from bouncing around during transport. The flat
screen monitor is affixed to the wall with security screws. The keyboard is on a pull-out
drawer under the operating bench.

Turn On Procedures
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To turn the system on, first be sure the generator has been turned on long enough to
warm up and settle down. The Power Frequency Meter should stabilize around 60 Hz
+/-. We want it to be running smoothly before firing up the computer. Turn on the
Uninterruptible Power Supply (UPS) located under the computer on the floor. The UPS
provides power conditioning, surge protection and will give you a few minutes to
smoothly shut down the computer if the generator dies while the computer is operating.
The UPS will beep when the power is not of sufficient voltage. (Note: Occasional
beeping will be experienced as the voltage varies and nothing to worry about.
Continuous beeping is an indication of power failure and the computer should be shut
down.) Then you may turn on both the monitor and the computer. The computer is
running Windows 2000 and takes a minute or two to complete the boot process.

Log-On

Once booted, you will be required to sign on. The basic sign-on screen asks for a user
name and a password. The common user name is “RACES”; the common user
password is the club callsign in lower case “k7rdg”.

Log-Off/Shutdown

When operations are complete, the computer should always be shut down properly.
Please ensure that you Log Off and Shutdown before turning off the generator. Once
the computer is turned off and the UPS is shut off you may turn off the generator. In an
emergency or the generator dies, still follow the basic shut down of logging off and
allowing the computer to shut down itself before turning off the monitor and the UPS.
You should have about 15 minutes of UPS power to shut down the computer gracefully.
Please ensure the UPS is also turned off so that the UPS battery is not run down while
parked.

Any problems with the computer should be reported to Bob Hollister (N7INK) or Lee llse
(KD7OED) as soon as possible to ensure that maintenance issues can be addressed
prior to the next mission. Write down any error messages encountered as completely
as possible to aid in troubleshooting.

APRS Operations

The software used for APRS operations is Ul-View32 and it is licensed to the CARA
club using the club call KTRDG. APRS is primarily used to support such activities as
the annual “la Vuelta de Bisbee” bike race. For APRS operations in the MCU you will
need to follow the following procedures.

1) First be sure the Yaesu FT-2600 radio is turned on and set for the APRS frequency
of 144.390. You will see “APRS” on the radio Alpha display or 144.390 if set from
frequency display. There is a vertical whip antenna installed on a mount located at the
top curb side at the rear of the MCU.

2) Next, turn on the Kantronics KAM-Plus TNC. It will already be connected to the serial
port 1 of the computer.
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3) Once the computer is booted and you are logged on, click on the “Ul-View32” icon to
start the APRS program. It will start and display the last used Precision Map segment.
Each time a new station is detected by the software, the software will plot it on the
computer screen and give you a voice announcement of the callsign in an English
accent. The software was written by an English ham. If you do not see the station on
the screen, it is probably out of the area for the map segment that you have selected.

4) To reset the location of the MCU icon on the map display and the transmitted
location, you will have to first update manually the grid coordinates of your location.
Along the top of the screen you will see an option named “Setup”. Once you click on
that, a drop down menu with several options will be presented. Select “Station Setup”.
A Popup window will appear. You will need to type in your current Latitude/Longitude
location determined from a GPS or from a mapping program. The format is:
# ## ##N which stand for Degrees. Minutes. Decimal Seconds in the Northern
Hemisphere. It should something like “31.30.15N” for the northing and “110.15.20W” for
the Westing. No other changes are required. Click “OK” and the Icon for K7TRDG-3 will
jump to that location on the map. Additionally you should change the “Beacon Text".
Again, select “Setup”, then “Status Text”. In this window, add your mission name. It
might something like this:

“$VERSION San Pedro Search” or

“$VERSION La Vuelta de Bisbee Bike Race”.
The $VERSION is a code that will also transmit the current version of the software we
are running and is not required. Click “OK” and then the beacon text will be updated. No
other entries or changes are required.

5) It takes a little practice selecting the appropriate map segment to display and moving
around on the map display. The basic map operations are as follows:

Zoom Map Out — Move the mouse cursor to the tool bar (usually on the right side
of the screen) and left click the mouse cursor on the “Up/Down” icon (double headed
arrow).

Zoom Map In — Right Click the Up/Down Arrow.

To change or navigate to a different map segment, hold down the “Ctrl” key and also
press and hold down the left mouse button. The cursor will change from an arrow to a
hand. Now drag the map in the direction that allows you to see the map segment of
interest.

6) To shut down the program, click on the (x) in the top right corner of the screen and
this will shut down both Ul-View32 and the Precision Map program.

Amateur Contact Log
The Amateur Contact Log software allows us to maintain a contact log of our activity

when we are out just having fun such as Paradise, Field Day, or other contest type
activities. Itis quite easy to use. If you have used paper logs in the past, you will

As of: 2/4/2007 12 -9



quickly recognize the typical data items that are filled in to document our contacts. The
logs can also be downloaded or printed as necessary.

Once the AC Log 2.7 icon is activated you will see the basic operating screen. Fill in
the fields on the lower part of the screen starting with the Callsign of the station worked.
Use the <TAB> key to move to the next data element. A copy of the QRZ callsign data
base is linked to the software and will display the name and basic information
associated with the callsign. Once you have all the information and completed the
contact, click the “Log Contact” button or the enter key and the information will be added
to the database.

AIRMAIL/PACTOR/HF Email Operations

There are two primary outlets for HF email: the Amateur WinLink 2000 network or the
Army MARS digital network. The Army MARS program sponsors a PACTOR bulletin
board system (BBS) that is operated 24/7. If you are a MARS member, you will be able
to use the Airmail software to link with the MARS BBS network to send and receive
digital traffic. This manual assumes that persons using the Army MARS network are
basically familiar with those operations and will therefore we will focus on the Amateur
WinLink 2000 network.

HF PACTOR operations use the ICOM 706 transceiver and the SCS PTC-llex terminal
node controller (TNC). There are a variety of antennas available for this radio. At least
one needs to be selected from the antenna patch panel and connected as there are
normally none directly connected to the radio. You may select from a roof mounted
vertical, a HamStick dipole on the mast, or the NVIS inverted V. Please select the
appropriate antenna for the band you wish to operate on and be sure the radio is
connected to the correct antenna on the patch panel. The default setting is for the roof
mounted vertical.

Turn on the IC-706. This will normally automatically power up the TNC as well. if the
SCS TNC it did not come on with the radio, turn it on now using the power switch toggle
on the right rear of the unit. It is easy to feel. You are now ready to activate the Airmail
software. There are two Airmail icons on the Windows Desktop, one for Amateur
operations and one for MARS operations. They are configured for their specific
operation.

Using Airmail 2000 software is similar to using Outlook or Outlook Express. It is used to
prepare, send, and receive messages. There are two primary modules, the Message
Index module for message preparation and processing and a separate Terminal module
for actually sending and receiving (connecting to a WinLink 2000 (WL2K) station)
messages.

Once you have opened to the first screen you are ready to prepare a message for

transmission. Begin by selecting “File”, then “New” from the drop down menu. The
Airmail application has an address book that has already been populated with our most

As of: 2/4/2007 12 - 10



commonly supported agencies and it will automatically open. Select the name from the
address book you wish to send the message to by highlighting your choice and clicking
on “OK”. If your choice is not there, you will have to add it to the address book by
selecting “New” from within the Address Book.

A new “Address Properties” window will open for you to fill in. Use a short name such as
first name and callsign (Bob -N7INK) or an abbreviated Agency name (i.e. SV ARC) for
the “Name:” field. The “To:” field should contain the correct email address for the
individual or agency (n7ink@cox.net or SVARC@XXX.org). This next step is critical,
you must also fill in the “Post Via:” field with “WL2K”. Accept this address by clicking on
the “OK” button. This will return you to the “Address Book” to now select your address.

You should now see a screen to prepare your message on. You could also select a
station to send a Courtesy Copy (Cc:) to using the same process as selecting your To:
address. Type in a “Subject:” and proceed to type the message. You can type it directly
or import from a text file. Once you have the message complete, Click on the icon that
looks like a “letterbox” to post it for sending. You are not done yet. The window will
close and take you back to the Message Processing window. Your message will now
show up in the Outbox ready to be sent. If you have no further messages to prepare,
click the “Terminal Window” icon (looks like a Yagi Antenna on a blue background) to
switch to the “Terminal Window”.

Caution: You must be a General Class or higher licensee or have a General Class or
higher present as a control operator to proceed.

The next step requires knowledge of the various WL2K Mailbox stations as well as
propagation characteristics to reach them based on time of day and distance. Along the
top of the Terminal Window you will see two important pull-down windows. One window
shows the callsigns of the various mailbox stations, the second shows the frequencies
that the station scans for connection. The table below identifies US based stations.
Locations identified with a “+” sign indicate “express stations” that restrict their connect
protocols to PACTOR 11 (400 to 800 bps) and PACTOR Il (1400 to 3600 bps.) Our
station is PACTOR I/1I/11l capable.

State Callsign Name and City

AK KL7EDK Jerry in Fairbanks

CA KABIQA Tom in Rancho Santa Fe
CA KB6YNO Eric in Petaluma

CA K6IXA Grady in Atwater

CA W6IM Rod in San Diego

CA + K6CYC Scott in Los Angeles

FL NOIA Bud in Deltona

FL WX4J Earl in Switzerland

FL + KN6KB Rick in Rockledge

FL + WA2DXQ Dave in Ft. Lauderdale
HI AH6QK Richard in Kaneohe, Oahu
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IL WIGSS Charles in East Peoria
IL WIOMR Ken in Keensburg

KY + KASET Scott in Murray

LA + WBOTAX Dennis in EIm Grove
MA W1O0ON Doc in Bedford

MT Wu3Vv Jim in Great Falls

OH N8PGR Hans in North Royalton
TN + K4CJX Steve in Nashville

TX WB5KSD Jon in Farmersville

TX WD8DHF Gary in Harker Heights
VA KQ4ET Joel in Virginia Beach
WA W7BO John in Woodland

WA + W71J Bill in Spanway

As you click on the station callsign window, you will see near the bottom right of the
screen the location of the selected station. When you select a specific frequency to use
from the second drop down window, the dial frequency at the bottom of the screen will
show you exact frequency to dial in to ensure connection. Check to see if the system is
in “Handshake mode” (the two hands shaking icon). Press the antenna tune button on
the front of the radio to be sure you have an appropriate SWR match for the radio. You
are now ready to try to make a PACTOR connection. Next move your cursor to the
“Green” light. It will momentarily turn yellow as a caution to be sure you have a clear
frequency, assuming you do have a clear frequency, click on it. The computer/TNC will
now attempt to connect to the station. If after 8-9 attempts, the connect fails and times
out, you may want to try again. Most mailbox stations scan several frequencies so if it
gets busy with another station on another frequency, it may not hear you the first few
times you attempt to connect. If after a few minutes you are unable to connect, try
another station. Remember that you will have to change the antenna if you select
another band. | typically have had good luck with NOIA/FL or KACJX/TN on 20 meters
during the day. | have also connected with them, TX and CA stations on 40 meters in
the evening. A little experience goes a long way when determining time of day and best
propagation.

Once you have connected, the system will auto detect what you have in the “Outbox”
and what is waiting to send you from the system. It will normally make the connection,
send and receive the traffic and disconnect without further interaction. Once it has
disconnected, you may return to the Message window to read any new traffic. Closing
the application is as simple as clicking on the red “X” in the upper right hand corner.

Softros Instant Messaging

This software tool will provide you the ability to send brief notes back and forth between
computers located in the command van or wireless network enabled computers within a
couple hundred feet of the van with the Wireless network router. The software is
automatically booted and runs in background when you start up the computer. It also
keeps a history log of all messages sent between the different stations on the network,
so be sure you watch what and how you type your messages. You may not know who
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all is reading these messages. The icon to access this software is found at the bottom
of the windows screen and looks like a caption balloon that you might see in a cartoon
in the newspapers. When you scroll across it, you should see a label “Softros LAN
Messenger”. Click on it to open. A small window will open and show you the computer
names of those within range of the network. To send a message to one of these users,
click on a name and a conversation window will open. The top part of the window
shows both sides of the conversation as it is carried on. The bottom part of the pane is
for you to type your message into. Each time you press enter, that portion of your text
is automatically sent to the other party. A useful tool is the “History Viewer”. You may
either print or save to a file for historical purposes your conversation(s).
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